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Compare: Automatic Rotate

® |f needed the Compare Tool now automatically rotates the view of the
reference file. No need anymore to alter the original artwork.

Provided design has
different page boxes
andis rotated

Reproduction

Confidential -Company Proprietary

Reference artwork is
rotated and aligned
with production
artwork for easy

compare



Compare: Compare Color HSV Mode

»  When comparing files pixel by pixel color changes
between versions can cover more severe mistakes

® HSV compare mode allows you toignore shallow
color changes to uncover differences in content

Provided design has
different channels
and/orcolors thanthe

Provided Artwork repro duction Printready Artwork
-7 T =
} E:
e Adjusting the color
EL threshold allows youto
focus on possible

Original differences in content

Reproduction

Compareln HSV Mode

ESKOS
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Share & Approve
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Share & Approve: Folder Approval

® Automatically start the approval cycle at upload when uploading from ArtPro+
or DeskPack

Approval Preferences

Forward Approvals ©
(1] (2] @ Dontallow

Q Allow Approval Forwarding to registered users

Upload Upload () Allow Approval Forwarding to registered and unregistered users

AssetName Asset Name

Salmon.pdf

Salmon.pdf
Folder

S&A-TestSite_Name/JH_ArtPro+

S&A-TestSite_Name/JH_ArtPro+
v [ JH-ArtPro+_folder
@ Customer A v [ JH-ArtPro+_folder .
Auto Start Approval Settings ©
B Customer B @B -H Folder Approval
W JH Folder Approval JH_AESaas folder
L + Do not start approval after upload

B JH_AESaas folder B H_subfolder

B JH_subfolder B Shore 8 Approve 9 Auto start approval after file upload
P 9 Ask to set approval cycle on file upload

Create New Folder Create New Folder

The folder approval settings will

be applied. Apply folder approval

settings

ESKOS
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Share & Approve: Inside ArtPro+ (1)

BNR S %

Colors Images Placed Art  Messages  Action List

Share & Appr

YOLA_PINK_BOX.pdf

Version 2 - File shared to @
cloud

cC o2 4

TR

View in browser

» BT .

All Versions

Al Users

All Review States

Visualizing

Show All Show Selected Hide All

annotations 7
from e
previous J———
versions

Version 1 ~

1 [ De Meulemeester, Stef nec 16, 2022 03 247
Please check code

2 [ De Meulemeester, Stef nec 16,2022 03244
Needs better alignment

3 [0 De Meulemeester, Stef o 05, 202 05,161

New compound

Bl R

Upload Linked
ARD/ZAE for easy
3D viewing

B ENERGY

APP.E+LIM
Create New Folder ) - r
L1 alaln ece
4 Upload Structural Design
& upl 9 = oo ; R
An Asset with this name already exists, = -

a new version will be created

Cancel Upload

Object Browser  Colors  Images  Placed Art M

Share & Approve

Only store lﬂ <No Asset

Exists>

Annotationsin
Share & Approve :
forinternal clo

communications
Create asset without Upload -

Upload to Existing Asset

ESKOS
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Share & Approve: Inside ArtPro+ (2)

Create New Folder

Import PDF Annotations

Upload Structural Design

Import PDF
Notes from

received
PDF

Cancel Upload

B T - <

All Versions -
All Users. -
All Review States -

[ External and Intemal ﬁ“

External and Internal

External

Internal

1 @ sdme oct 19, 2023 09:07AM
@ Kindly verify the barcode

Reply

Confidential - Company Proprietary

Classify
annotations
as internal
or external

ESKOS



Easier Automation
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PDF Action List: Grouping Actions

Q
All Conditional Action (If... Then...)
Document Group Actions
Layers Run Existing Action List
Separations Show Message
Selection
Page Boxes
Transform
ppposra Use “Group Actions”
Cle G for bringing structure
to your Action Lists
and simplified
duplication
Group Actions

This action allows to group actions and to add a description
of the group.

* Description:

» Group Actions
Prepare selected image

» Group Actions
Clip and apply blend mode

¥ Group Actions
» Description:
» Select Objects by Attribute
* Rename Object
» Select Objects by Attribute
» Rename Object
» Select Objects by Attribute

» Rename Object

Confidential - Company Proprietary

Cancel

ESKO



PDF Action List: Run Existing Action List

“Run Existing Action List” helps you to simplify management and minimize the
amount of needed Action Lists

O‘ » Description:
All Conditional Action (If... Then...)
Documen t Group Actions ¥ Run Existing Action List
Layers Run Existing Action List
Separations Show Message Action List: 003_Images/Downsample And Clip
Selection Action List Parameters
Page Boxes
Transform Resol
Clipboard ut
Barcode
Flow Control
Browse for the Action
List you want to
7 / execute

Enable to overrule
existing parameters

ESKO
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PDF Action Lists: New Actions

Clip on Shape

¥ Clip on Shape x

This action has no parameters.

Add Related Clip Groups to Selection

¥ Add Related Clip Groups to Selection

This action has no parameters.

ESKO
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PDF Action Lists: New Actions

New shortcut to “run with options”

o Hold down “shift” key to invoke the options dialog before running an Action List

Preferences

B = P @ e, Q@ % E O

General  Keyboard Engine  Color

Printing Methods ~ Preflight  Actlon Lists ~ Normalized PDF  Extensis

Shortcut Scheme:  Customized [C]

To change a keyboard shorteut, double-click its key combination and then press the desired keys.

Category Command Shorteut = .

File Local Action Lists Run \;uth Options
Edit 000_SharedActions i
Object 001_Set Page Boxes to selected objects

Select 002_Create Cutting Line from selected objects

Prepress 003_Get cut shape from CAD

View 001_MyActions

Window Customers

Help Crown

Debug Set Boxes

Toolbar Processing Steps

Turn Off All Structural Processing Steps

Enable to always open
options dialogwhen
runningan action list

ESKO
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More Advanced Marks

Fancions | Q

 Page Boxes
Media Box
Trim Box
Crop Box
Bleed Box
Art Box

Media Box Width
Media Box Height
Media Box Top
Media Box Bottom
Media Box Left
Media Box Right

( (( SIGN( ( | Media Box Height = -

Media Box Width ' ) ) *45) + 45) *1°)|

Rotate Formula Support for Input File Mark and External File Mark

e0e

B Normal | 100% ~

= B L B 6

Oblect Browser  Colors Images Placed At Messages  Actionlists  Share & Approve

e

Untitled @ 404,7%

+

LIGERTENTETESEIN Ropeat for Separations Mark 1

 Printing Units ~

Content:

Repeat:

(31 / Printing Units

Other Separations:

Repeat Direction:

“F Trim Box ~

Al Separations
Artwork Separations.

Processing Step Separations
Artwork Separations and Varnish

Custom...

Remove

=5 0,0000 mm

10,0000 mm

i:3
S

2 D M

3 Expand @ NoTags ~ & Nene ~

m o ® ® 0

Shaper Barcode  Screening  Trapping  Warp

Preview

v Document

~ Crosshair

~ Page Boxes
v Layers O

1 Dynamic...
Layer 1

Repeat for Grid Mark 2

Repeat for Grid Mark 1

GIEIE]

v Separations

T1 Repeat for Separations Mark 1

Document Profile: Coated FOGRA3S (S0 12..
e

)

Automation Engine

Legend ~

s |0

~ Document
Barcodes

Document Information

Links
Page Boxes
Separations

Structural Design Files

Placed Art |

Text Marks—Updated Variable ‘Placed Art’

3l

®| tame L
®© [} opaque White a0

® [ pavionesrse | 3 @O
© M PANTONE 335 C 2 @O
© M panToNe7S6C) 1 @

® ® decut g

8 PRI R

¥ Quality Control

= Total Area Coverage

Limit:_100:

Repeat for Separations Mark: Support for Printing Units

Confidential - Company Proprietary

Allow Resize Mark inside Repeat for Grid Mark

ESKOS



Export CIP3
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Export CIP3

® ArtPro+ can provide offset front ends with ink coverage information

Export to PDF Print Side:  Front e
Export to Gravure TIFF Compression: JPEG B
Resolution: 72,0 dpi

Anti-aliasing: 2 pixels B
Add cut data

Export to JOF Layout \
Export to CIP3

For applicable grids,
the cutting data can be
exported

Coneel

ESKOS
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Plate Cut
Improvements
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Plate Cut

® The Plate Cut algorithm now prefers horizontal and vertical cuts over curves

and supports roll-over bleeds

g |

—— S ——— =

New

ESKOS
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Plate

Plate Cut: PDF Action List

Module

® You can automatethe creation of plate cutting paths with the new PDF Action
and utilize “Selected Path for Plate Cut”

 Select Objects by Attribute
Select

All of the following rules are true:

equals MyPlateCut Guide |18 =®

¥ Create Plate Cutting Paths

Web Direction: Eﬁ ’j

Plate Width: Media Box

Plate Circumference: © From grid or page box

Specify manually ‘ |
Create Cutting Paths:  Use Selected Path
Use custom uffsel:| |
Corner Radius: ‘ﬂ,DDDD mm ‘|
Gap at Seam: ‘O,DDDD mm '|

ESKOS
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Text Recognition Including Non-activated Fonts

You can expand the search for best matching fonts with a custom font folder

0 =

General

Keyboard  Automation Engine

Keyboard Increment:

External Editor for Images:

Length Unit:

Area Unit:

Font Size Unit:

Stroke Unit:

Resolution Unit For Gravure:

Numeric Field Display:

Default Structural Design Profile:

Color Management

Preferences

o® Q

Printing Methods  Preflight

1,0000 mm
Default Image Editor

Millimeters

Square millimeters
Points

Millimeters

Pixels per centimeter

Show additional decimals

Selection Color: M Light Red
Highlight Color: Ml Red
Full
[Users/fr

Font Folder for Text

"Remember My Choice" Dialogs:

Reset All

%

Action Lists

eEEEE ®

®e

Normalized PDF

= O

Extensis

You can add one
folder for Text
Recognition to

search for matching
fonts

@ AMPros Fle Edi Object Select Prepress View Window Melp Debug

=

B

()

R

Helvetics
Best Matching Fonts
Hetvetica Reguisr (81%
Asial Ragular (91% )
Arial Narrow Regular (91% )
Microsoft Sans Serf Regular (815 |
#uial Unicade MS Regular (915 |
Shree Devanagarl 714 Bald (91% |
Ga Reguiar (315
System Font Regular (315 )
Hehtica Neve LT Std 55 Roman (80% )
Hotvatica Nove Rogular {30% )
Swis7Z18T Raman (0% )
Avenir Roman (30% )
Futura Bk BT Boak (89% )
Verdana Reguler (89% )
Hiragire Maru Gothic Pro W4 [83% ]
Hiragina Maru Gothi ProN Wa (80% |
PT Sans Raguiar (8% )
‘Square?21 BT Roman (88% )
‘Swis721Cn BT Roman (88% }
Bast Matching Non-Activated Fonts
Phelvetica 3
Asial Regular

Used in Decument
A1 Unicade MS
Halvatic
UriSarstight

Auailable System Fonts
Acadomy Engraved LET
AiBayan
aiie
Al Tarik
American Tyneariter
Al Mone
Apple Braile
Apple Chancery
Agple Color Emos
Agple SO Gatlic Nec.
Apple Symbals
AppleGathic
AppleMtyungio
Aial
Al Black
prep—
sl Hebrew Schalar
sl Narrow
Al Roundied MT Bold

Non-activated font
matches are
indicated as links to
their locations. Just
click to reveal.

S_YELLOW with CAD.pg

8,3881 x 2,3023 mm ~|

SJFITNESS

CITET G e



Glyph Inspector

® The new glyph inspector gives you full access to all available characters of a
given font

& ArtPro+ File Edit Object Select Prepress View Window Help Debug & &

ece > ALCIS_Carton.pdf + Job: FRWO_EW22_04_VDP @ 1332%
= BN B 6 % - HtE D N ™ O

an Select  Sha Barcode  Screening  Trapping

Colors Images Placed Art Messages Action List  Share & Approve

ART =
D |Z / NoStroke ~ 3 Mormal | 100% ~ A CalibriBold |12,000pt = A Glyphs ~ 4 32,3611 x 15,2400 mm ~

-

Calibri
Bold

Show:  Entire Font

Q
235 £ 502z L l]:NJNlAI'C‘DUI':II‘.‘I
00 AAAZ 66 KoQOQ 302Dz 6 H p
. N A AEET T DORRDOS AN
The Glyph inspector 87 AE 8060671 A¢gtL 728 u
. AlE $ QR Y ABBBCDDDDPD
becomes available EE g g EF e h A A AL Rk
H KL DL L mmmiunNNNOGD OO
when text is ANNNOBARANOABOGET
Se|ected uly 000 0vwwx X v 2zzet
' PRHKZOI4FbBBEDbCcCa?9 fh
plk t K nlap 2t t|y 2 g 3 s5|di
lilni & 7 6la 6 6 bladd @i

=
=

ESKOS
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Barcodes
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Barcodes

® Support for new GS1 Application n ata Content Format et

el Require
|dentifiers ‘
4330 Madmum tlemperatune in Na+ME+]-] [FHCT]
. . el Fahrenheit
® GS1 Application Identifier character set PR PO o

check (N, X, Y, Z) Cotis

4332 Minimum temperatune in Mad+ME+[=] [FHCT)
. Fahrenheit
® Small Box warningsfor 2D codes ; |

4333 Minimum temperatune in Na+hs]-] [FHET)
Calsius

7241 AIDC mindia typé MNa+M2 [FREC)

T2 ersion Control Mumber WX4+¥..25 [FRCT)
[VCH)

BO30 Digital Signature (DigSlg)  N4+Z.90 [FHCT)

ESKOS
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Trapping Improvement: Flexo Print

® Trap Highlightsfor Flexo Print , e m— 1
 Automatic VTR

Distance: 0,5000 mm

B
End Caps:
—

Close gaps smaller than: 0,0000 mm

Overshoot: Allow overshoot

o Providing Flexo Print
& Trap highlights for flexo print parameters enables
First Printable Dot: 0,8%

ArtPro+ to take dot

Prints as:  14,9%

Range: 30,2% gainin highlights into
account when
0 62 objects or groups have trap tags trapplng

0 Only artwork layers with printing state on will be taken into account.

Cancel Update Trap Layer

ESKOS
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Trapping Improvement: Meshes

The Trapper is now recognizing meshes and is creating traps accordingly

ESKOS
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Warping
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Warping Improvements: Print On Metal Cylinder

® Studio Improvements allow you to predistort for preformed metal containers

ArtPro+

Confidential - Company Proprietary



More Functionality

ESKOC



Color Management Improvements

= ag
= =

A B (i ] *ﬁ S

‘Object Browser  Colors  Images  Placed Art  Messages  ActionLists  Share & Approve.

X CMYK | 220 ppi ~

B Normal | 100% ~

-+ 60,0364 x 49,9918 mm | 0,0000° ~

Color Space:  CMYK

Color Profile: Coated FOGRA39 (ISO 12647-2:2004)

xel Size: 520 x 433 px
Resolution: 220 ppi
Transparency: Yes

@ Extracting and linking is not possible for images with
features

Replace...

Edit in Editor

lam CMYK

Fogra39
C=36 M=11Y=99 K=1

Images with tagged

ICC profiles can now

be resolved into the
document profile

Unlock All
Hide
Show All

Path
Compound
Clipping Mask
Opacity Mask
Image

Text

Placed Art

Remove Color Profile
Recolor...

Shaper...
Spread/Choke...

Expand
Rasterize...
Clean

Clip

Convert to Placeholder...

N¥2
®3
N3

R R Y

H®E
ORT

> t Keep Color Values |

Keep Visual Appearance

Confidential - Company Proprietary

B R R O % L3

[Z] = cMyk | 220ppi v @ Normal | 100% v - 60,0364 x 49,9918 mm | 0,0000° ~

Color Space:  CMYK
Color Profile: None
Pixel Size: 520 x 433 px
Resolution: 220 ppi
Transparency: Yes

Extract and Link
Replace...

Edit in Editor

lam CMYK
Fogra39
C=36 M=11 Y=99 K=1

ESKOS



Rasterize Improvements

® Avoid Staircasing in Clipping Masks of Rasterized Objects

]

Resolution:  300,0 ppi

o
| Include Background

Use this option to retain the visual appearance of blend
modes and transparency. Mon-printing layers are
excluded.

Cancel

Old New

ESKOS
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Remake Compound

® Remake compound from selected sub-paths.

& ArtPro+  File Edil“Select Prepress View Window Help Debug

@ ArtPro+ File Edit Object Select Prepress View Window Help Debug
‘ece
: @ B 6 % e
Object Browser Colors Images  Flaced At Messages  ActionLists  Share & Approve
Hlé#dm Layer1 =
= I / NoStroke v ¥ NoEffect ~

B Normal | 100% ~
<Compound Path>

<Compound Path>

F =
e0e Arrange >
= {=[m} Transform... M
= - Im Transform ) S
Object rowser  Colors images | oo Apaln & Approve
Object Browser [ Group nd Path>
Ungroup 03%G
52 e ke v ¥ NoEffect v Normal | 100% ~
Lock 2 £
Hide
Path > \
Compound > \
Clipping Mask > ‘l
Opacity Mask > /
Image >
Text >
Placed Art >

Remove Color Profile
Recolor...

Shaper...
Spread/Choke...

Rasterize...

Clean

Clip

Convert to Placeholder...

Simply use
“compound” to
extract selected sub-

paths into a new
compound

Confidential - Company Proprietary
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Classic Normalized PDF

When opening classic Normalized PDF files, you can now ignore missing

external references

®®
| Could not find the following linked artwork in the
2 / Normalized PDF file:
® o * POMEGRANATE_soft.psd

Choose 'Browse’ to relocate all missing links and open the
file in its original state, 'Open Anyway' to open the file
without the missing real data or 'Cancel' to cancel opening
the file.

Open Anyway Cancel

® Missing Real Data

ArtPro+iswarning
about missing
external references
asthis data is
needed for
production!

Confidential - Company Proprietary

PowerLayout Grid 1
PowerLayout Grid 3
PowerLayout Grid 4
PowerLayout Grid 5
PowerLayout Grid 6
<Placed Art>
<Placed Art>
<Placed Art>
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